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 When you write, please be sure to include this book’s title and author as well as your name 
and email address. We will carefully review your comments and share them with the author 
and editors who worked on the book.  

      Email:       feedback@quepublishing.com    

  Mail:        Que Publishing
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800 East 96th Street
Indianapolis, IN 46240 USA       

  Reader Services  
 Visit our website and register this book at  quepublishing.com/register  for convenient access to any 
updates, downloads, or errata that might be available for this book.          



 The pivot table is the single most powerful com-
mand in all of Excel. Pivot tables came along during 
the 1990s when Microsoft and Lotus were locked 
in a bitter battle for dominance of the spreadsheet 
market. The race to continually add enhanced fea-
tures to their respective products during the mid-
1990s led to many incredible features, but none as 
powerful as the pivot table.  

 With a pivot table, you can take 1 million rows of 
transactional data and transform it into a summary 
report in seconds. If you can drag a mouse, you can 
create a pivot table. In addition to quickly summa-
rizing and calculating data, pivot tables enable you 
to change your analysis on the fly by simply moving 
fields from one area of a report to another.  

 No other tool in Excel gives you the flexibility and 
analytical power of a pivot table.   

     What You Will Learn from This Book  
 It is widely agreed that close to 60 percent of Excel 
users leave 80 percent of Excel untouched. That 
is, most users do not tap into the full potential of 
Excel’s built-in utilities. Of these utilities, the most 
prolific by far is the pivot table. Despite the fact that 
pivot tables have been a cornerstone of Excel for 
almost 20 years, they remain one of the most under-
utilized tools in the entire Microsoft Office Suite. 
Having picked up this book, you are savvy enough 
to have heard of pivot tables or even have used them 
on occasion. You have a  sense that pivot tables pro-
vide a power that you are not using, and you want 
to learn how to leverage that power to increase your 
productivity quickly.  

   What You Will Learn from This Book   ................  1   

   What Is New in Excel 2013’s Pivot Tables   .........  2   

   Skills Required to Use This Book   ......................  2   

   Invention of the Pivot Table   ............................  4   

   Sample Files Used in This Book   .......................  7   

   Conventions Used in This Book   ........................  7     
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 Within the first two chapters, you will be able to create basic pivot tables, increase your 
productivity, and produce reports in minutes instead of hours. Within the first seven chap-
ters, you will be able to output complex pivot reports with drill-down capabilities and 
accompanying charts. By the end of the book, you will be able to build a dynamic pivot 
table reporting system.   

  What Is New in Excel 2013’s Pivot Tables  
 Luckily, Microsoft continues to invest heavily in Business Intelligence (BI), and pivot tables 
are the front end that let you access the new features. Some of the features added to Excel 
2013 pivot tables include the following:  

     Excel offers thumbnails for four possible pivot tables in the Data Analysis Lens. If you 
happen to need one of these pivot tables, it requires three mouse clicks.   

    Excel offers thumbnails for ten recommended pivot tables when you choose Insert, 
Recommended Pivot Tables. If you are not sure how best to summarize your data, 
you’ll find plenty of inspiration in this dialog.   

    A new timeline slicer enables you to easily filter your pivot table by month, quarter, 
or year. Excel 2010 had added visual filters called  slicers —the timeline in Excel 2013 
extends slicers for date fields.   

    All people using any version of Excel 2013 (except Excel RT on a tablet) can now jump 
through a few hoops to build a pivot table using data on multiple worksheets. This 
functionality replaces the need to join two worksheets using  VLOOKUP .   

    People using the client version of Office 365 or Excel Professional Plus can enable the 
PowerPivot add-in. PowerPivot provides drag-and-drop functionality to link tables, 
worksheets, SQL Server, and more. PowerPivot adds better calculated fields.   

    PowerView enables you to animate your pivot tables in an ad-hoc query tool.    

 If you skipped Excel 2010, you missed these new features:  

     New calculations for Rank, Percentage of Parent, and Running Percent of Total.   

    Repeat Item Labels to fill in the blanks along the outer column fields in a pivot table.     

Slicers to create visual filters.

  Skills Required to Use This Book  
 We have created a reference that is comprehensive enough for hard-core analysts yet rel-
evant to casual users of Excel. The bulk of the book covers how to use pivot tables in the 
Excel user interface.  Chapter   10   , “Mashing up Data with PowerPivot,” delves into the 
PowerPivot window.  Chapter   14   , “Advanced PivotTable Tips and Techniques,” describes 
how to create pivot tables in Excel’s powerful VBA macro language. This means that any 
user who has a firm grasp of the basics, such as preparing data, copying, pasting, and enter-
ing simple formulas, should not have a problem understanding the concepts in this book.    
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 Your manager asks you to create a one-page summary of a sales database. He would like to see total revenue by region 

and product. Suppose you do not know how to use pivot tables. You will have to use dozens of keystrokes or mouse clicks 

to complete this task.  

 First, you have to build the outline of the report:  

    1.   Copy the Product column to a blank section of the worksheet.   

   2.   Use Data, Remove Duplicates to eliminate the duplicates.   

   3.   Delete the Product heading.   

   4.   Copy the unique list of products and then use Paste Special Transpose to turn the list sideways.   

   5.   Delete the vertical list of products.   

   6.   Copy the Region column to a blank section of the worksheet.   

   7.   Use Data, Remove Duplicates to remove the duplicates.   

   8.   Delete the Region heading.   

   9.   Cut and paste the products so they appear left of and below the regions.    

 At this point, I count 27 mouse clicks or keystrokes. You’ve built the shell of the final report, but there are no numbers 

inside yet, as shown in  Figure   I.1   .  

 

 Next, you need to build the relatively new  SUMIFS  function to total the revenue for the intersection of a region and 

product. As shown in  Figure   I.2   , a formula of  =SUMIFS($G$2:$G$564,$C$2:$C$564,L$1,$B$2:$B$564,

$K2)  does the trick. It takes 52 characters plus the Enter key to finish the formula, but I managed to enter the formula in 

36 clicks or keystrokes using some clever navigation tricks I’ve learned over the years.  

 

 Provided you are adept at using the fill handle, you need just two more mouse drags to copy the formula to the rest of 

the table.  

  C A S E  S T U D Y  :   L I F E  B E F O R E  P I V O T  T A B L E S  

 Figure I.1  
 It took 27 clicks to get to 
this point.        

 Figure I.2  
 If this was the year 2006, 
the  SUMIFS  function 
would have been an 
uglier  SUMPRODUCT  
function.        
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 Enter the heading “Total” in the total row and total column. You can do this in nine keystrokes, if you type the first head-

ing, press Ctrl+Enter to stay in the same cell, then use Copy, select cell for second heading and Paste.  

 If you select K1:P6 and press Alt+Enter, you can add the total formulas in three keystrokes.  

 You have a nice summary report, as shown in  Figure   I.3   . It took 77 clicks or keystrokes. If you could pull all this off in 5 or 

10 minutes, you would probably be fairly proud of your Excel prowess—there were some good tricks among those 77 

operations.   

 Figure I.3  
 A mere 77 operations 
later, you have a sum-
mary report.        

 Hand the report to your manager. Within a few minutes, your manager will come back with one of the following 

requests, which will certainly cause a lot of rework:  

     Could you put products down the side and regions across the top?   

    Could you show me the same report for only the manufacturing customers?   

    Could you show profit instead of revenue?   

    Could you copy this report for each of the customers?      

  Invention of the Pivot Table  
 When the actual pivot table was invented is in dispute. Although the Excel team coined 
the term  Pivot Table , it did not appear in Excel until 1993. Pito Salas and his team at Lotus 
were working on the pivot table concept in 1986 and released Lotus Improv in 1991. Before 
then, Javelin offered functionality similar to pivot tables.  

 The core concept behind a pivot table is that the data, formulas, and data views are stored 
separately. Each column has a name, and you can group and rearrange the data by dragging 
field names to various positions on the report.    



Invention of the Pivot Table 5

 Say you need to produce the same report in the last case study but you want to use a pivot table. Excel 2013 offers you 10 

thumbnails of recommended pivot tables to get you close to the goal. Follow these steps:  

    1.   Click the Insert tab of the ribbon.   

   2.   Click Recommended PivotTables. The first recommended item is Revenue by Region (see  Figure   I.4   ).    

   3.   Click OK to accept the first pivot table.   

   4.   Drag the Product field from the PivotTable Field List to the COLUMNS area (see  Figure   I.5   ).  

  C A S E  S T U D Y  :   L I F E  A F T E R  P I V O T  T A B L E S  

 Figure I.4  
 The first recommended 
pivot table is as close 
as you will get to the 
required report.        
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     5.   Unselect Field Headers on the right side of the ribbon.    

 After just five clicks of the mouse, you have the report shown in  Figure   I.6   .   

 Figure I.5  
 To finish the report, drag 
the Product heading to 
the COLUMNS area.        

 Figure I.6  
 It took five clicks to create 
this report.        

 In addition, when your manager comes back with one of the requests near the end of the prior case study, a pivot table 

makes it easy for you to make the changes. You find out about all of these methods in the chapters that follow, but here 

is a quick recap:  

     Could you put products down the side and regions across the top? (10 seconds: drag Product to Rows and Region to 

Columns.)   

    Could you show me the same report for only the Manufacturing customers? (15 seconds: select Insert Slicer, Sector, 

click OK, click Manufacturing.)   
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    Could you show profit instead of revenue? (10 seconds: uncheck Revenue, check Profit.)   

    Could you copy this report for each of the customers? (30 seconds: move Customer to Report Filter, open the tiny 

drop-down next to the Options button, choose Show Report Filter Pages, click OK.)      

  Sample Files Used in This Book  
 All data files used throughout this book are available for download from  www.mrexcel.com/
pivotbookdata2013.html . You will find one Excel workbook per chapter and should be able 
to achieve the exact results shown in the figures in this book by starting with the raw data 
on the Data worksheet. If you simply want to work with the final pivot table, you can find it 
in the workbook as well.   

  Conventions Used in This Book  
 This book follows certain conventions:  

      Monospace —Text messages you see onscreen or code appears in a monospace font.   

     Bold —Text you type appears in a bold font.   

     Italic —New and important terms appear in italics.   

    Initial Caps—Tab names, dialog names, and dialog elements are presented with initial 
capital letters so you can identify them easily.    

  Referring to Versions  
 From 1997 through 2003, Microsoft released similar versions of Excel known as Excel 97, 
Excel 2000, Excel 2002/XP, and Excel 2003. This book refers to those versions as “legacy 
versions” of Excel.   

  Referring to Ribbon Commands  
 Office 2007 introduced a new interface called the ribbon. The ribbon is composed of sev-
eral tabs labeled Home, Insert, Page Layout, and so on. When you click the Page Layout 
tab, you see the icons available on the Page Layout tab.  

 When the active cell is inside a pivot table, two new tabs appear on the ribbon. In the 
help files, Microsoft calls these tabs “PivotTable Tools | Analyze” and “PivotTable Tools 
| Design.” For convenience, this book refers to these elements as the Analyze tab and the 
Design tab, respectively. The Slicer feature has a ribbon tab that Microsoft calls “Slicer 
Tools | Options.” This book refers to this as the Slicer tab. Excel 2013 introduced the 
Timeline Tools | Options tab. This book calls this the Timeline tab.  

http://www.mrexcel.com/pivotbookdata2013.html
http://www.mrexcel.com/pivotbookdata2013.html
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 In some cases, the ribbon icon leads to a drop-down with additional choices. In these cases, 
the book lists the hierarchy of ribbon, icon, menu choice, and submenu choice. For exam-
ple, in  Figure   I.7   , the shorthand specifies “select Design, Report Layout, Repeat All Item 
Labels.”    

 Figure I.7  
 For shorthand, instruc-
tions might say to select 
Design, Report Layout, 
Repeat All Item Labels.        

  Special Elements  
 This book contains the following special elements:    

 Cast studies provide a real-world look at topics previously introduced in the chapter.   

  C A S E  S T U D Y  

  Notes provide additional information outside the main thread of the chapter discussion that might 

be useful for you to know.   

N
O

T
E

  Tips provide quick workarounds and time-saving techniques to help you do your work more 

efficiently.   T
I

P

  Cautions warn you about potential pitfalls you might encounter. Pay attention to Cautions because 

they alert you to problems that otherwise could cause you hours of frustration.       

C A U T I O N
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 Customizing a Pivot Table  

 Although pivot tables provide an extremely fast 
way to summarize data, sometimes the pivot table 
defaults are not exactly what you need. In this case, 
you can use many powerful settings to tweak the 
information in your pivot table. These tweaks range 
from making cosmetic changes to changing the 
underlying calculation used in the pivot table.  

 In Excel 2013, you find controls to customize the 
pivot table in myriad places: the Analyze tab, Design 
tab, Field Settings dialog, Data Field Settings dia-
log, PivotTable Options dialog, and context menus. 
Rather than cover each set of controls sequentially, 
this chapter seeks to cover the following functional 
areas in making pivot table customization:  

      Minor cosmetic changes    —Change blanks to 
zeros, adjust the number format, and rename 
a field. The fact that you must correct these 
defaults in every pivot table that you create is 
annoying.   

     Layout changes    —Compare three possible lay-
outs, show/hide subtotals and totals, and repeat 
row labels.   

     Major cosmetic changes    —Use table styles to 
format your table quickly.   

     Summary calculations    —Change from Sum to 
Count, Min, Max, and more. If you have a table 
that defaults to Count of Revenue instead of 
Sum of Revenue, you need to visit the section 
on this topic.   

     Advanced calculations    —Use settings to show 
data as a running total, percent of total, rank, 
percent of parent item, and more.   

     Other options    —Review more obscure options 
found throughout the Excel interface.     

      Making Common Cosmetic Changes   ..............  46   

   Making Report Layout Changes   ....................  51   

   Customizing the Pivot Table Appearance 
with Styles and Themes  ................................  59   

   Changing Summary Calculations   ..................  63   

   Adding and Removing Subtotals  ...................  65   

   Changing the Calculation in a Value Field   .....  67     

     I N  T H I S  C H A P T E R 
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     Making Common Cosmetic Changes  
 You need to make a few changes to almost every pivot table to make it easier to understand 
and interpret.  Figure   3.1    shows a typical pivot table. To create this pivot table, open the 
 Chapter   3    data file. Select Insert, Pivot Table, OK. Check the Sector and Revenue fields, 
and drag the Region field to the COLUMNS area.   

 Figure 3.1  
 A typical pivot table 
before customization.        

 This default pivot table contains several annoying items that you might want to change 
quickly:  

     The default table style uses no gridlines, which makes it difficult to follow the rows and 
columns across.   

    Numbers in the VALUES area are in a general number format. There are no commas, 
currency symbols, and so on.   

    For sparse data sets, many blanks appear in the VALUES area. The blank cell in B5 
indicates that there were no Communications sales in the Midwest. Most people prefer 
to see zeros instead of blanks.   

    Excel renames fields in the VALUES area with the unimaginative name Sum of 
Revenue. You can change this name.    

 You can correct each of these annoyances with just a few mouse clicks. The following sec-
tions address each issue.  

  Applying a Table Style to Restore Gridlines  
 The default pivot table layout contains no gridlines and is rather plain. Fortunately, you can 
apply a table style. Any table style that you choose is better than the default.  
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 Follow these steps to apply a table style:  

    1.   Make sure that the active cell is in the pivot table.   

   2.   From the ribbon, select the Design tab.   

   3.   Three arrows appear at the right side of the PivotTable Style gallery. Click the bottom 
arrow to open the complete gallery, which is shown in  Figure   3.2   .    

 Figure 3.2  
 The gallery contains 85 
styles to choose from.        

   4.   Choose any style other than the first style from the drop-down. Styles toward the bot-
tom of the gallery tend to have more formatting.   

   5.   Select the check box for Banded Rows to the left of the PivotTable Styles gallery. This 
draws gridlines in light styles and adds row stripes in dark styles.    

 It does not matter which style you choose from the gallery; any of the 84 other styles are 
better than the default style.  

➔   For more details about customizing styles,  see  “Customizing the Pivot Table Appearance with Styles 
and Themes,” p. 59 .      

  Changing the Number Format to Add Thousands Separators  
 If you have gone to the trouble of formatting your underlying data, you might expect that 
the pivot table would capture some of this formatting. Unfortunately, it does not. Even if 
your underlying data fields were formatted with a certain numeric format, the default pivot 
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table presents values formatted with a general format. As a sign of some progress, when you 
create pivot tables from PowerPivot, you can specify the number format for a field before 
creating the pivot table. This functionality has not come to regular pivot tables, yet. For 
more about PowerPivot, read  Chapter   10   , “Mashing Up Data  with PowerPivot.”  

 For example, in the figures in this chapter, the numbers are in the thousands or tens of 
thousands. At this level of sales, you would normally have a thousands separator and prob-
ably no decimal places. Although the original data had a numeric format applied, the pivot 
table routinely formats your numbers in an ugly general style.  

 You will be tempted to format the numbers using the right-click menu and choosing 
Number Format. This is not the best way to go. You will be tempted to format the cells 
using the tools on the Home tab. This is not the way to go. Either of these methods tempo-
rarily fixes the problem, but you lose the formatting as soon as you move a field in the pivot 
table. The right way to solve the problem is to use the Number Format button in the Value 
Field Settings dialog.  

 You have three ways to get to this dialog:  

     Right-click a number in the VALUES area of the pivot table and select Value Field 
Settings.   

    Click the drop-down on the Sum of Revenue field in the drop zones of the PivotTable 
Field List and then select Value Field Settings from the context menu.   

    Select any cell in the VALUES area of the pivot table. From the Analyze tab, select 
Field Settings from the Active Field group.    

 As shown in  Figure   3.3   , the Value Field Settings dialog is displayed. To change the numeric 
format, click the Number Format button in the lower-left corner.   

 Figure 3.3  
 Display the Value Field 
Settings dialog and then 
click Number Format.        

Number Format

 In the Format Cells dialog, you can choose any built-in number format or choose a custom 
format. For example, choose Currency, as shown in  Figure   3.4   .   
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  Replacing Blanks with Zeros  
 One of the elements of good spreadsheet design is that you should never leave blank cells in 
a numeric section of the worksheet. Even Microsoft believes in this rule; if your source data 
for a pivot table contains one million numeric cells and one blank cell, Excel 2013 treats the 
entire column as if it is text and chooses to Count the column instead of Sum. This is why 
it is incredibly annoying that the default setting for a pivot table leaves many blanks in the 
VALUES area of some pivot tables.  

 The blank tells you that there were no sales for that particular combination of labels. In 
the default view, an actual zero is used to indicate that there was activity, but the total sales 
were zero. This value might mean that a customer bought something and then returned it, 
resulting in net sales of zero. Although there are limited applications in which you need to 
differentiate between having no sales and having net zero sales, this seems rare. In 99% of 
the cases, you should fill in the blank cells with zeros.  

 Follow these steps to change this setting for the current pivot table:  

    1.   Right-click any cell in the pivot table and choose PivotTable Options.   

   2.   On the Layout & Format tab in the Format section, type  0  next to the field labeled For 
Empty Cells Show (see  Figure   3.5   ).   

   3.   Click OK to accept the change.    

 The result is that the pivot table is filled with zeros instead of blanks, as shown in  
Figure   3.6   .     

 Figure 3.4  
 Choose an easier-to-read 
number format from the 
Format Cells dialog.        

  Although Excel 2013 offers a Live Preview feature for many formatting settings, the Format Cells 

dialog does not offer one. To see the changes, you must assign the number format, close the 

Format dialog, and then close the Value Field Settings.    

N
O

T
E
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 Figure 3.5  
 Enter a zero in the For 
Empty Cells Show box to 
replace the blank cells 
with zero.        

Enter a zero here.

 Figure 3.6  
 Your report is now a solid 
contiguous block of non-
blank cells.        

  Changing a Field Name  
 Every field in the final pivot table has a name. Fields in the row, column, and filter areas 
inherit their names from the heading in the source data. Fields in the data section are given 
names such as Sum of Revenue. In some instances, you might prefer to print a different 
name in the pivot table. You might prefer Total Revenue instead of the default name. In 
these situations, the capability to change your field names comes in quite handy.  

 Although many of the names are inherited from headings in the original data set, when 
your data is from an external data source, you might not have control over field names. In 
these cases, you might want to change the names of the fields as well.  
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 To change a field name in the VALUES area, follow these steps:  

    1.   Select a cell in the pivot table that contains the appropriate type of value. You might 
have a pivot table with both Sum of Quantity and Sum of Revenue in the VALUES 
area. Choose a cell that contains a Sum of Revenue value.   

   2.   Go to the Analyze tab in the ribbon. A Pivot Field Name text box appears below the 
heading of Active Field. The box currently contains Sum of Revenue.   

   3.   Type a new name in the box, as shown in  Figure   3.7   . Click a cell in your pivot table to 
complete the entry and have the heading in A3 change. The name of the field title in 
the VALUES drop zone also changes to reflect the new name.    

  One common frustration occurs when you would like to rename Sum of Revenue to Revenue. The 

problem is that this name is not allowed because it is not unique; you already have a Revenue field 

in the source data. To work around this limitation, you can name the field and add a space to the 

end of the name. Excel considers “Revenue ” (with a space) to be different from “Revenue” (with no 

space). Because this change is cosmetic, the readers of your spreadsheet do not notice the space 

after the name.      

N
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  Making Report Layout Changes  
 Excel 2013 offers three report layout styles. The Excel team continues to offer the newer 
Compact Layout as the default report layout, even though I continually hound them 
about the fact that people who work in the real world would rather use the Tabular Report 
Layout, or at least would like to have a choice about which one to use as a default.  

 If you consider three report layouts, and the ability to show subtotals at the top or bottom, 
plus choices for blank rows and Repeat All Item Labels, you have 16 different layout pos-
sibilities available.  

 Layout changes are controlled in the Layout group of the Design tab, as shown in  Figure 
  3.8   . This group offers four icons:  

      Subtotals    —Moves subtotals to the top or bottom of each group or turns them off.    
     Grand Totals    —Turns the grand totals on or off for rows and columns.   

 Figure 3.7  
 The name typed in 
the Custom Name box 
appears in the pivot 
table. Although names 
should be unique, you 
can trick Excel into 
accepting a similar name 
by adding a space to the 
end of it.        
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  Using the New Compact Layout  
 By default, all new pivot tables use the Compact layout shown in  Figure   3.6   . In this lay-
out, multiple fields in the row area are stacked in column A. Note in the figure that the 
Communications sector and the AT&T customer are both in column A.  

 The Compact form is suited for using the Expand and Collapse icons. Select one of the 
Sector value cells such as Communications in A5. Click the Collapse Field icon on the 
Analyze tab. Excel hides all the customer details and shows only the sectors, as shown in 
 Figure   3.9   .   
 After a field is collapsed, you can show detail for individual items by using the plus icons in 
column A, or you can click Expand Field on the Analyze tab to see the detail again.  

 Figure 3.8  
 The Layout group on the 
Design tab offers differ-
ent layouts and options 
for totals.        

  If you select a cell in the innermost row field and click Expand Field on the Options tab, Excel dis-

plays the Show Detail dialog, as shown in  Figure   3.10   , to enable you to add a new innermost row 

field.     

T
I
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     Report Layout    —Uses the Compact, Outline, or Tabular forms. Offers an option to 
repeat item labels.   

     Blank Rows    —Inserts or removes blank lines after each group.    

  For the statisticians in the audience, you would think that three layouts × two repeat options × 

two subtotal location options × two blank row options would be 24 layouts. However, choosing 

Repeat All Item Labels does not work with the Compact Form, thus eliminating four combinations. 

In addition, Subtotals at the Top of Each Group does not work with the Tabular layout, eliminating 

another four combinations.   

N
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  Using the Outline Form Layout  
 When you select Design, Layout, Report Layout, Show in Outline Form, Excel puts each 
row field in a separate column. The pivot table shown in  Figure   3.11    is one column wider, 
with revenue values starting in C instead of B. This is a small price to pay for allowing each 
field to occupy its own column. Soon, you will find out how to convert a pivot table to val-
ues so you can further sort or filter. When you do this, you will want each field in its own 
column.  

 The Excel team added the Repeat All Item Labels option to the Report Layout tab starting 
in Excel 2010. This alleviated a lot of busy work because it becomes two clicks to fill in all 
the blank cells along the outer row fields. Choosing to repeat the item labels causes values 
to appear in cells A6:A7, A9:A10, and A12:A15 of  Figure   3.11   .  

  Figure   3.11    shows the pivot table in Outline form with labels repeated.   
 This layout is better suited if you plan to copy the values from the pivot table to a new loca-
tion for further analysis. Although the Compact layout offers a clever approach by squeez-
ing multiple fields in one column, it is not ideal for reusing the data later.  

 Figure 3.9  
 Click the Collapse Field 
icon to hide levels of 
detail.        

 Figure 3.10  
 When you attempt to 
expand the innermost 
field, Excel offers to add a 
new innermost field.        
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 Figure 3.11  
 The Outline layout puts 
each row field in a sepa-
rate column.        

 By default, both the Compact and Outline layouts put the subtotals at the top of each 
group. You can use the Subtotals drop-down on the Design tab to move the totals to the 
bottom of each group, as shown in  Figure   3.12   . In Outline view, this causes a not-really-
useful heading row to appear at the top of each group. Cell A5 contains “Communications” 
without any additional data in the columns to the right. Consequently, the pivot table 
occupies 44 rows instead of 37 rows because each of the seven sector categories has an extra 
header.    

 Figure 3.12  
 With subtotals at the 
bottom of each group, 
the pivot table occupies 
several more rows.        

  Using the Traditional Tabular Layout  
 Pivot table veterans will recognize the Tabular layout shown in  Figure   3.13   . This layout 
is similar to the one that has been used in pivot tables since their invention through Excel 
2003. In this layout, the subtotals can never appear at the top of the group. The new Repeat 
All Item Labels works with this layout, as shown in  Figure   3.13   .   
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 The Tabular layout is the best layout if you expect to use the resulting summary data in a 
subsequent analysis. If you wanted to reuse the table in  Figure   3.13   , you would do addi-
tional “flattening” of the pivot table by choosing Subtotals, Do Not Show Subtotals, and 
Grand Totals, Off for Rows and Columns.    

 Figure 3.13  
 The Tabular layout is 
similar to pivot tables in 
legacy versions of Excel.        

 Say that you want to convert the pivot table shown in  Figure   3.13    to be a regular data set that you can sort, filter, chart, 

or export to another system. You don’t need the Sectors totals in rows 7, 10, 15, and so on. You don’t need the Grand 

Total at the bottom. And, depending on your future needs, you might want to move the Region field from the Columns 

area to the Rows area. This would allow you to add Cost and Profit as new columns in the final report.  

 Finally, you want to convert from a live pivot table to static values. To make these changes, follow these steps:  

    1.   Select any cell in the pivot table.   

   2.   From the Design tab, select Grand Totals, Off for Rows and Columns.   

   3.   Select Design, Subtotals, Do Not Show Subtotals.   

   4.   Drag the Region tile from the COLUMNS area in the PivotTable Field List. Drop this field between Sector and 

Customer in the ROWS area.   

   5.   Check Profit and Cost in the top of the PivotTable Field List. Because both fields are numeric, they move to the 

VALUES area and appear in the pivot table as new columns. The report is now a contiguous solid block of data, as 

shown in  Figure   3.14   .   

   6.   Select one cell in the pivot table. Press Ctrl+* to select all the data in the pivot table.    
   7.   Press Ctrl+C to copy the data from the pivot table.   

   8.   Select a blank section of a worksheet.   

   9.   Right-click and choose Paste Values to open the fly-out menu. Select Paste Values and Number Formatting, as 

shown in  Figure   3.15   . Excel pastes a static copy of the report to the worksheet.   

   10.   If you no longer need the original pivot table, select the entire pivot table and press the Delete key to clear the cells 

from the pivot table and free up the area of memory that was holding the pivot table cache.     

  C A S E  S T U D Y  :   C O N V E R T I N G  A  P I V O T  T A B L E  T O  V A L U E S  
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   The result is a solid block of summary data. These 27 rows are a summary of the 500+ rows in the original data 

set, but they also are suitable for exporting to other systems.    

 Figure 3.14  
 The pivot table now 
contains a solid block 
of data.        

 Figure 3.15  
 Use Paste Values to create 
a static version of the 
data.        

Paste Values and Number Formatting

  Controlling Blank Lines, Grand Totals, and Other Settings  
 Additional settings on the Design tab enable you to toggle various elements.  

 The Blank Rows drop-down offers a choice for Insert Blank Row After Each Item. This 
setting only applies to pivot tables with two or more row fields. Blank rows are not added 
after each item in the inner row field. You see a blank row after each group of items in the 
outer row fields. As shown in  Figure   3.16   , the blank row after each Region makes the report 
easier to read. However, if you remove Sector from the report, you would have only Region 
in the row fields and no blank rows would appear (see  Figure   3.17   ).    
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 Figure 3.16  
 The Blank Rows setting 
makes the report easier 
to read.        

 Figure 3.17  
 However, blank rows will 
not appear when there 
is only one item in the 
row field.        

  For those of you following along with the sample files, there was quite a leap from the pivot table 

in  Figure   3.14    to  Figure   3.16   , but it is still the same pivot table. Here is how to make the changes:  

 1.   Uncheck Sector, Customer, Profit and Cost in the Pivot Table Fields task pane.   
 2.   Drag the Product field to the Columns area.   
 3.   Recheck the Sector field to move it to the second Row field.   
 4.   Make sure the active cell is in column A.   
 5.    On the Design tab of the ribbon, open Subtotals and choose Show All Subtotals at the Bottom of 

the Group.   
 6.    Finally, as shown in  Figure   3.16   , open the Blank Rows drop-down and choose to add blank rows. 

To get to  Figure   3.17   , uncheck the Sector field.     

N
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 Grand totals can appear at the bottom of each column and/or at the end of each row, or 
they can be turned off altogether. Settings for grand totals appear in the Grand Totals drop-
down of the Layout group on the Design tab. The wording in this drop-down is a bit con-
fusing, so  Figure   3.18    shows what each option provides. The default is to show grand totals 
for rows and columns, as in  Figure   3.17   .  

 If you want a grand total column but no grand total at the bottom, choose On for Rows 
Only, as shown at the top of  Figure   3.18   . To me, this seems backward. To keep the grand 
total column, you have to choose to turn on grand totals for rows only. I guess the rationale 
is that each cell in F5:F8 is a grand total of the row to the left of the cell. Hence, you are 
showing the grand totals for each row, but not for the columns. Perhaps someday Microsoft 
will ship a version of Excel in English-Midwest where  this setting would be called “Keep 
the Grand Total Column.” But for now, it remains confusing.   

 Figure 3.18  
 The wording is confusing, 
but you can toggle off the 
grand total column, row, 
or both.        

 In a similar fashion, to show a grand total row but no grand total column, you open the 
Grand Totals menu and choose On for Columns Only. Again, in some twisted version of the 
English language, cell B18 is totaling the cells in the column above it.  

 The final choice, Off for Rows and Columns, is simple enough. Excel shows neither a grand 
total column nor a grand total row.  

 Back in Excel 2003, pivot tables were shown in Tabular layout and logical headings such as 
“Region” and “Product” would appear in the pivot table, as shown in the top pivot table in 
 Figure   3.19   . When the Excel team switched to Compact form, they replaced those head-
ings with “Row Labels” and “Column Labels.” These add nothing to the report. To toggle 
off those headings, look on the far right side of the Analyze tab for an icon called Field 
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Headers and click it to remove “Row Labels” and “Column Labels” from your pivot tables 
in Compact form.   

 Figure 3.19  
 The Compact form 
introduced in Excel 2007 
replaced useful headings 
with “Row Labels.” You 
can turn these off.        

  Customizing the Pivot Table Appearance with Styles and 
Themes  

 You can quickly apply color and formatting to a pivot table report using the 85 built-in 
styles in the PivotTable Styles gallery on the Design tab. These 85 styles are further modi-
fied by the four checkboxes to the left of the gallery. Combined with the 48 themes on the 
Page Layout tab, you have 65,280 easy ways to format a pivot table. If none of those pro-
vide what you need, you can define a new style.  

 Start with the four check boxes in the PivotTable Style Options group of the Design tab of 
the ribbon. You can choose to apply special formatting to the row headers, column headers, 
banded rows, or banded columns. My favorite choice here is banded rows, because it makes 

  When you arrange several pivot tables vertically, as in  Figure   3.19   , you’ll notice that changes in 

one pivot table change the column widths for the entire column, often causing #### to appear in 

the other pivot tables. By default, Excel changes the column width to AutoFit the pivot table but 

ignores anything else in the column. To turn off this default behavior, right-click each pivot table 

and choose PivotTable Options. In the first tab of the Options dialog, the second-to-last check box 

is AutoFit Column Widths On Update. Uncheck this box.     

C A U T I O N
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it easier for the reader’s eye to follow a row across a wide report. You should choose from 
these settings first because the choices here will modify the thumbnails shown in the Styles 
gallery.  

 The PivotTable Styles gallery on the Design tab offers 85 built-in styles. Grouped into 28 
styles each of Light, Medium, and Dark, the gallery offers variations on the accent colors 
used in the current theme. In  Figure   3.20   , you can see which styles in the gallery truly sup-
port banded rows and which just offer a bottom border between rows.  

 Note that you can modify the thumbnails for the 85 styles shown in the gallery by using the 
four check boxes in the PivotTable Style Options group.   

 Figure 3.20  
 The styles are shown 
here with accents for row 
headers, column headers, 
and alternating colors in 
the columns.        

True Banded Rows

Borders
Between Items

 The Live Preview feature in Excel 2013 works in the Styles gallery. As you hover your 
mouse cursor over style thumbnails, the worksheet shows a preview of the style.  

  Customizing a Style  
 You can create your own pivot table styles. The new styles are added to the gallery for the 
current workbook only. To use the custom style in another workbook, copy and temporarily 
paste the formatted pivot table to the other workbook. After the pivot table has been pasted, 
apply the custom style to an existing pivot table in your workbook and then delete the tem-
porary pivot table.  

 Say that you want to create a pivot table style in which the banded colors are three rows 
high. Follow these steps to create the new style:  

    1.   Find an existing style in the PivotTable Styles gallery that supports banded rows. 
Right-click the style in the gallery and select Duplicate. Excel displays the Modify 
PivotTable Quick Style dialog.   
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   2.   Choose a new name for the style. Excel initially appends a “2” to the existing style 
name, which means you have a name such as PivotStyleDark3 2. Type a better name, 
such as  Greenbar .   

   3.   In the Table Element list, click First Row Stripe. A new section called Stripe Size 
appears in the dialog.   

   4.   Select 3 from the Stripe Size drop-down, as shown in  Figure   3.21   .    

   5.   To change the stripe color, click the Format button. The Format Cells dialog appears. 
Click the Fill tab and then choose a fill color. If you want to be truly authentic, choose 
More Colors, Custom, and use Red=200, Green=225, Blue=204 to simulate 1980s-era 
greenbar paper. Click OK to accept the color and return to the Modify PivotTable 
Quick Style dialog.   

   6.   In the Table Element List, click Second Row Stripe. Change the Stripe Size drop-down 
to be 3. Modify the format to use a lighter color such as white.   

   7.   If you plan on creating more pivot tables in this workbook, choose the Set As Default 
PivotTable Style for This Document check box in the lower left.   

   8.   Optionally edit the colors for Header Row and Grand Total Row.   

   9.   Click OK to finish building the style. It is strange that the Excel team doesn’t auto-
matically apply this new style to the pivot table. After a few minutes of work to tweak 
the style, the pivot table does not change.   

   10.   Your new style should be the first thumbnail visible in the styles gallery. Click that style 
to apply it to the pivot table. (Provided you have not added more than seven custom 

 Figure 3.21  
 Customize the style in the 
Modify PivotTable Style 
dialog.        
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styles, the thumbnail should be visible in the closed gallery—you can choose it without 
reopening the gallery.)     

  Modifying Styles with Document Themes  
 The formatting options for pivot tables in Excel 2013 are impressive. The 84 styles, com-
bined with 16 combinations of the Style options, make for hundreds of possible format 
combinations.  

 In case you become tired of these combinations, you can visit the Themes drop-down on 
the Page Layout tab, where 48 built-in themes are available. Each theme has a new combi-
nation of accent colors, fonts, and shape effects.  

 To change a document theme, open the Themes drop-down on the Page Layout tab. 
Choose a new theme, and the colors used in the pivot table change to match the theme.  

  Changing the theme affects the entire workbook. It changes the colors and fonts, and affects all 

charts, shapes, tables, and pivot tables on all worksheets of the active workbook.   

C A U T I O N

  Some of the themes use unusual fonts. You can apply the colors from a theme without changing 

the fonts in your document by using the Colors drop-down next to the Themes menu, as shown in 

 Figure   3.22   .      
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 Figure 3.22  
 Choose new colors from 
the Colors menu.        
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  Changing Summary Calculations  
 When creating your pivot table report, by default Excel summarizes your data by either 
counting or summing the items. Instead of Sum or Count, you might want to choose func-
tions such as Min, Max, and Count Numeric. In all, 11 options are available. However, the 
common reason to change a summary calculation is that Excel incorrectly chose to count 
instead of sum your data.  

  Understanding Why One Blank Cell Causes a Count  
 If all the cells in a column contain numeric data, Excel chooses to sum. If just one cell is 
either blank or contains text, Excel chooses to count.  

 In  Figure   3.23   , the worksheet contains mostly numeric entries but has a single blank cell in 
G2. The one blank cell is enough to cause Excel to count the data instead of summing.   

 Figure 3.23  
 The single blank cell in G2 
causes problems in the 
default pivot table.        

 In Excel 2013, the first clue that you have a problem appears when you select the check box 
for Revenue in the Fields section of the PivotTable Field List. If Excel moves the Revenue 
field to the Rows drop zone, you know that Excel considers the field to be text instead of 
numeric.  

 Be vigilant while dragging fields into the Values drop zone. If a calculation appears to be 
dramatically low, check to see if the field name reads Count of Revenue instead of Sum of 
Revenue. When you create the pivot table in  Figure   3.24   , you should notice that your com-
pany has only $562 in revenue instead of millions. This should be a hint that the heading in 
B3 reads Count of Revenue instead of Sum of Revenue. In fact, 562 is one less than 
the number of records in the data set—Excel doesn’t include the blank cell in the Count 
function.   

 Figure 3.24  
 Your revenue numbers 
look anemic. Notice in 
cell B3 that Excel chose to 
count instead of sum the 
revenue. This often hap-
pens if you inadvertently 
have one blank cell in 
your Revenue column.        
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 To override the incorrect Count calculation, right-click any pivot table cell in the Revenue 
column. Choose Summarize Values By and then choose Sum (see  Figure   3.25   ).    

 Figure 3.25  
 Change the function 
from Count to Sum in 
the Summarize Values By 
drop-down.        

  Using Functions Other Than Count or Sum  
 The settings for Summarize Values By and Show Values As were temporarily promoted to 
drop-downs in the Excel 2010 ribbon, but they are no longer in the ribbon in Excel 2013. 
All of the pivot table calculations icons for the Quick Access Toolbar were removed from 
Excel 2013. They were apparently removed to make space for Insert Timeline, Drill Down, 
Drill Up, and Recommended Pivot Tables. If you were a fan of Summarize Values By and 
Show Values As, you can continue to use them from the right-click menu or by selecting a 
cell and pressing Shift+F10.  

 The options have always been available in the Value Field Settings dialog.  

 Excel offers six functions through the Summarize Values By command, plus five more 
options when you select More Options. The options available are as follows:  

      Sum    —Provides a total of all numeric data.   

     Count    —Counts all cells, including numeric, text, and error cells. This is equivalent to 
the Excel function  =COUNTA() .   

     Average    —Provides an average.   

     Max    —Shows the largest value.   

     Min    —Shows the smallest value.   

     Product    —Multiplies all the cells together. For example, if your data set has cells with 
values of 3, 4, and 5, the product would be 60.   

     Count Nums    —Counts only the numeric cells. This is equivalent to the Excel function 
 =COUNT() .   
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     StdDev and StdDevP    —Calculate the standard deviation. Use StdDevP if your data set 
contains the complete population. Use StdDev if your data set contains a sample of the 
population.   

     Var and VarP    —Calculate the statistical variance. Use VarP if your data contains a 
complete population. If your data contains only a sampling of the complete population, 
use Var to estimate the variance.    

  Standard deviations explain how tightly results are grouped around the mean.     

N
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  Adding and Removing Subtotals  
 Subtotals are an essential feature of pivot table reporting. Sometimes you might want to 
suppress the display of subtotals, and other times you might want to show more than one 
subtotal per field.  

  Suppress Subtotals When You Have Many Row Fields  
 When you have many row fields in your report, subtotals can mire your view. For example, 
in  Figure   3.26   , there is no need to show subtotals for each market because there is only one 
sales rep for each market.   

 Figure 3.26  
 Sometimes you do not 
need subtotals at every 
level.        

 If you used the Subtotals drop-down on the Design tab, you would turn off all subtotals, 
including the Region subtotals and the Market subtotals. The Region subtotals are still 
providing good information, so you want to use the Subtotals setting in the Field Settings 
dialog. Choose one cell in the Market column. On the Analyze tab, choose Field Settings. 
Change the Subtotals setting from Automatic to None (see  Figure   3.27   ).   
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 To remove subtotals for the Market field, click the Market field in the drop zone section 
of the PivotTable Field List. Select Field Settings. In the Field Settings dialog, select None 
under Subtotals, as shown in  Figure   3.27   .   

  Adding Multiple Subtotals for One Field  
 You can add customized subtotals to a row or column label field. Select the Region field in 
the bottom of the PivotTable Field List and select Field Settings.  

 In the Field Settings dialog for the Region field, select Custom and then select the types 
of subtotals you would like to see. The dialog in  Figure   3.28    shows five custom subtotals 
selected for the Region field. It is rare to see pivot tables use this setting. It is not perfect. 
Note that the Count of 211 records automatically gets a currency format like the rest of the 
column, even though this is not a dollar figure. Also, the Average of $12,333 for South is an 
average of the detail records, not an average of the individual Market totals.  

 Figure 3.27  
 Use the Subtotals setting 
in the field list to turn off 
subtotals for one field.        

  If you need to calculate the average of the four regions, you can do it with the DAX formula lan-

guage and PowerPivot. See  Chapter   10   .      T
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  Changing the Calculation in a Value Field  
 The Value Field Settings dialog offers 11 options on the Summarize Values As tab and 15 
main options on the Show Values As tab. Whereas the options under the first tab are the 
basic Sum, Average, Count, Max, and Min options that are ubiquitous throughout Excel, 
the 15 options under Show Values As offer interesting options such as % of Total, Running 
Total, and Ranks.  

 For Excel 2010 only, these options appeared as two drop-down menus in the ribbon. They 
were removed from the 2013 ribbon, but they still exist in the right-click menu. Because 
many of the calculations require one or two additional settings, you end up back in an extra 
dialog anyway. If you get in the habit of using the Value Field Settings dialog, you will have 
access to all the settings in one dialog.  

 Six of the Show Values As calculations were introduced in Excel 2010. These include % of 
Parent Item, Rank, and % Running Total In.  

 The following examples show how to use the various calculation options. To contrast 
the various settings, you can build a pivot table where you drag the Revenue field to the 
VALUES area nine separate times. Each shows up as a new column in the pivot table. Over 
the course of the rest of the chapter, you see the settings required for the calculations in 
each column.  

 To change the calculation for a field, select one value cell for the field and click the Field 
Settings button on the Analyze tab of the ribbon. The Value Field Settings dialog is similar 
to the Field Settings dialog, but it has two tabs. The first tab, Summarize Values By, con-
tains Sum, Count, Average, Max, Min, Product, Count Numbers, StdDev, StdDevP, Var, 
and VarP. Choosing one of these 11 calculation options changes the data in the column. 
In  Figure   3.29   , columns B through D show various settings from the Summarize Values 
By tab.   

 Figure 3.28  
 By selecting the Custom 
option in the Subtotals 
section, you can specify 
multiple subtotals for 
one field.        
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 Column B is the default Sum calculation. It shows the total of all records for a given mar-
ket. Column C shows the Average order for each item by Market. Column D shows a 
count of the records. You can change the heading to say “# of Orders” or “# of Records” or 
whatever is appropriate. Note that the count is the actual count of records, not the count of 
distinct items. Counting distinct items has been difficult in pivot tables, but now is possible 
using PowerPivot. See  Chapter   10    for more details.  

 Far more interesting options appear on the Show Values As tab of the Value Field Settings 
dialog, as shown in Figure 3.30. Fifteen options appear in the drop-down. Depending on 
the option you choose, you might need to specify either a Base Field or a Base Field and 
a Base Item. Columns E through J in  Figure   3.29    show some of the calculations possible 
using Show Values As.   

 Figure 3.29  
 Choose from the 11 
summary calculations on 
this tab.        

 Figure 3.30  
 Fifteen different ways to 
show data are available 
on this tab.        

Rename the field as appropriate.

Choose 1 of 15 calculations
from this drop-down.

Base Field and Base Item are selectively enabled.

  Table   3.1    summarizes the Show Values As options.  
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  Table 3.1   Calculations in Show Value As  

  Show Value As     Additional Required 
Information   

  Description   

 No Calculation   None  

  % of Grand Total    None    Shows percentages so all the detail cells in the 
pivot table total 100%.  

 % of Column Total   None   Shows percentages that total up and down the 
pivot table to 100%.  

  % of Row Total    None    Shows percentages that total across the pivot 
table to 100%.  

 % of Parent Row Total   None   With multiple row fields, shows a row’s percent-
age of the parent item’s total row.  

  % of Parent Column 
Total  

  None    With multiple column fields, shows a column’s 
percentage of the parent column’s total.  

 Index   None   Calculates the relative importance of items.  

  % of Parent Total    Base Field only    With multiple row and/or column fields, calcu-
lates a cell’s percent of the parent item’s total.  

 Running Total In   Base Field only   Calculates a running total.  

  % Running Total In    Base Field only    Calculates a running total as a percentage of the 
total.  

 Rank Smallest to 
Largest  

 Base Field only   Provides a numeric rank, with 1 as the smallest 
item.  

  Rank Largest to 
Smallest  

  Base Field only    Provides a numeric rank, with 1 as the largest 
item.  

 % of   Base Field and Base Item   Expresses the values for one item as a percentage 
of another item.  

  Difference From    Base Field and Base Item    Shows the difference of one item compared to 
another item or to the previous item.  

 % Difference From   Base Field and Base Item   Shows the percent difference of one item com-
pared to another item or to the previous item.  

 The capability to create custom calculations is another example of the unique flexibility of 
pivot table reports. With the Show Data As setting, you can change the calculation for a 
particular data field to be based on other cells in the VALUES area.  

 The following sections illustrate a number of Show Values As options.  
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  Showing Percentage of Total  
 Column E of  Figure   3.29    shows the % of Total. New York with $2.1 million in revenue 
represents 31.67% of the $6.7 million total revenue. Column E uses % of Column Total 
on the Show Values As tab. Two other similar options are % of Row Total and % of Grand 
Total. Choose one of these based on whether your text fields are going down the report, 
across the report, or both down and across.   

  Using % Of to Compare One Line to Another Line  
 The % Of option enables you to compare one item to another item. For example, the cur-
rent data set shows that New York is the largest market. Perhaps this company started in 
New York and has the largest concentration of customers in New York. Perhaps the home 
office is in New York. The people in New York might have a New York–centric view of the 
world and want to show how all of the other markets are doing as a percentage of New 
York. Cell E6 of  Figure   3.31    shows that Atlanta is about 25% the size of New York in  sales.  

 To set up this calculation, choose Show Values As, % Of. For the Base Field, choose Market 
because this is the only field in the ROWS area. For the Base Item, choose New York. The 
result is shown in  Figure   3.31   .    

 Figure 3.31  
 This report is created 
using the % Of option 
with New York as the 
Base Item.        

  Showing Rank  
 Two ranking options were added in Excel 2010. Column G of  Figure   3.32    shows Rank 
Largest to Smallest. New York is ranked #1, Minneapolis is #12. A similar option is Rank 
Smallest to Largest, which would be good for the pro golf tour.   
 To set up a rank, choose Value Field Settings, Show Values As, Rank Largest to Smallest. 
You are required to choose a Base Field. In this example, because Market is the only row 
field, it is the Base Field.  



71Changing the Calculation in a Value Field

3

 These rank options in Excel 2013 show that pivot tables have a strange way of dealing with 
ties. I say  strange  because they do not match any of the methods already established by the 
Excel functions  =RANK() ,  =RANK.AVG() , and  =RANK.EQ() . For example, if the top two markets 
have a tie, they are both assigned a rank of 1, and the third market is assigned a rank of 2.   

  Tracking Running Total and Percent of Running Total  
 Running total calculations is common in reports where you have months running down the 
column or when you want to show that the top  N  customers make up  N % of the revenue. 
The Running Total In calculation has been in Excel for many versions. The % Running 
Total In setting was added in Excel 2010.  

 In  Figure   3.33   , cell I8 shows that the top four markets account for 76.97% of the total sales.   

 Figure 3.32  
 The Rank options were 
added in Excel 2010.        

 Figure 3.33  
 Show running totals or 
a running percentage 
of total.        

  To produce this figure, you have to use the Sort feature, which is discussed in depth in  Chapter   4   , 

“Grouping, Sorting, and Filtering Pivot Data.” To create a similar analysis with the sample file, go 

to the drop-down in A4 and choose More Sort Options, Descending, by Total. Also note that the % 

Change From calculation in column J is not compatible with sorting.   
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 To specify Running Total In (as shown in Column H) or % Running Total In (Column J), 
select Field Settings, Show Values As, Running Total In. You have to specify a Base Field, 
which in this case is the row field: Market.   

  Display Change from a Previous Field  
  Figure   3.34    shows the % Difference From setting. This calculation requires a base field and 
base item. You could show how each market compares to New York by specifying New York 
as the base item. This would be similar to  Figure   3.31   , except each market would be shown 
as a percentage of New York.   

 Figure 3.34  
 The % Difference From 
options enable you to 
compare each row to the 
previous or next row.        

 When you have date fields, it would make sense to use % Difference From and choose 
(previous) as the base item. Note the first cell will not have a calculation because there is no 
previous data in the pivot table.   

  Tracking Percent of Parent Item  
 The legacy % of Total settings always divide the current item by the grand total. In  Figure 
  3.35   , cell E4 says that Chicago is 2.75% of the total data set. A common question at the 
MrExcel.com message board is how to calculate Chicago’s revenue as a percentage of the 
Midwest region total. This was possible but difficult before Excel 2010. Starting in Excel 
2010, Excel added the % of Parent Row, % of Parent Column, and % of Parent Total.  

 To set up this calculation in Excel 2013, use Field Settings, Show Values As, % of Parent 
Row Total. Cell D4 in  Figure   3.35    shows that Chicago’s $184K is 10.59% of the Midwest 
Total of $1,741K.   
 Although it makes sense, the calculation on the subtotal rows might seem confusing. D4:D8 
shows the percentage of each market as compared to the Midwest total. The values in D9, 
D11, D16, and D19 are comparing the region total to the grand total. For example, the 
31.67% in D11 is saying that the Northeast region’s $2.1 million is a little less than a third 
of the $6.7 million grand total.   
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  Track Relative Importance with the Index Option  

 The final option, Index, creates a somewhat obscure calculation. Microsoft claims that 
this calculation describes the relative importance of a cell within a column. In  Figure   3.36   , 
Georgia peaches have an index of 2.55 and California peaches have an index of 0.50. If the 
peach crop is wiped out next year, it will be more devastating to Georgia fruit production 
than to California fruit production.   

 Figure 3.35  
 An option in Excel 2013 
enables you to calculate 
a percentage of the par-
ent row.        

 Figure 3.36  
 Using the Index function, 
Excel shows that peach 
sales are more impor-
tant in Georgia than in 
California.        

 Here is the exact calculation: First, divide Georgia peaches by Georgia total. This is 
180/210, or 0.86. Next, divide total peach production (285) by total fruit production (847). 
This shows that peaches have an importance ratio of 0.34. Now, divide the first ratio by the 
second ratio: 0.86 / 0.34.  

 In Ohio, apples have an index of 4.91, so an apple blight would be bad for the Ohio fruit 
industry.  

 However, even after writing about this calculation for 10 years, there are parts that I don’t 
quite comprehend. What if a state like Hawaii relied on productions of lychees but lychees 
were nearly immaterial to U.S. fruit production? If lychees were half of Hawaii fruit pro-
duction, but 0.001 of U.S. fruit production, the Index calculation would skyrocket to 500.     
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     Next Steps  
 Note that the following pivot table customizations are covered in subsequent chapters:  

     Sorting a pivot table is covered in  Chapter   4   .   

    Filtering records in a pivot table is covered in  Chapter   4   .   

    Grouping daily dates up to months or years is covered in  Chapter   4   .   

    Adding new calculated fields is covered in  Chapter   5   , “Performing Calculations Within 
Your Pivot Tables.”   

    Using data visualizations and conditional formatting in a pivot table is covered in 
 Chapter   4   .    

 Using these tools is a great way to focus your pivot table on the largest drivers of success 
for your business.     
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  AutoShow, executive overviews,   

336 - 338  
  behind the scenes,   14 - 15  
  breaking out of the mold with cube 

functions,   202 - 203  
  building in VBA,   302 - 304  

  adding fields to data area,   304 - 305  
  building with PowerPivot add-in, 

  235 - 236  
  calculated fields, DAX (Data Analysis 

Expressions),   238  
  calculating,   326  

  addressing issues with two or more 
data fields,   326 - 327  

  calculated data fields,   329 - 330  
  calculated items,   330    
  calculations,   327 - 329  
  groups,   332 - 333  
  Show Values As tab,   333 - 334  

  columns area,   13 - 14  
  comparing tables,   368 - 369  
  compatibility,   15 - 16  
  conditional formatting,   149 - 151  
  converting to values,   56  
  creating  

  from Data Model,   226 - 227  
  new with Data Model,   173 - 174  
  with PowerPivot,   249 - 250  

  creating basic pivot tables,   22 - 24  
  adding fields to reports,   25 - 27  
  adding layers,   27  
  rearranging,   28  
  report filters,   29 - 30  

  creating reports for each region or 
model,   340 - 344  

  creating reports showing revenue by 
category,   312 - 315  

  adding subtotals to get page breaks, 
  322 - 323  

  changing default number format, 
  318 - 319  

  controlling sort order with 
AutoSort,   318  

  copying finished pivot tables as val-
ues to a new workbook,   320 - 321  

  eliminating blank cells,   317 - 318  
  formatting,   321  
  putting it all together,   323 - 326  
  rolling daily dates up to years,   

315 - 317  
  suppressing subtotals for multiple 

row fields,   319 - 320  
  table layout,   315  

  creating with external sources,   175  
  Microsoft Access,   175 - 178  
  SQL Server,   178 - 181  
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  customizing,   45  
  adding/removing subtotals,   65 - 67  
  appearance,   59 - 62  
  changing summary calculations, 

  63 - 65  
  cosmetic changes.   See  cosmetic 

changes 
  report layout changes.   See  report 

layout changes 
  default state,   314 - 315  
  defined,   9  
  deleting underlying pivot tables,   146  
  determining size of finished pivot 

tables to convert it to values,   309 - 311  
  exploding data sets to different tabs, 

  378 - 379  
  exploding data sets to different work-

books,   379 - 381  
  filtering,   94 - 95  
  filters area,   14  
  formatting VBA (Visual Basic for 

Applications),   305 - 307  
  frequency distribution, creating,   376  
  limitations of VBA (Visual Basic for 

Applications),   307 - 312  
  multiple consolidation pivot tables, 

creating,   158 - 162  
  versus PowerPivot,   236 - 237  
  rank number fields, adding,   365 - 366  
  rearranging,   28  

  time intelligence,   251  
  reasons for using,   10 - 11  
  refreshing  

  all pivot tables in a workbook at the 
same time,   360  

  automatically,   359 - 360  
  rows area,   13  
  ShowDetail,   338 - 340  
  sorting,   87  

  custom lists,   92 - 93  
  customers into high-to-low 

sequence based on revenue,   87 - 90  
  manual sort sequence,   91 - 92  

  synchronizing with combo box,   
290 - 294  

  transposing data sets,   371 - 374  
  turning into hard data,   361 - 362  
  values area,   12 - 13  
  when to use,   11 - 12   

   PivotFilters.Add method,   345   

   PivotLayout Object,   136   

   PivotTable Field List dialog,   24   

   PivotTable Field List interface,   26   

   PivotTable Fields list,   83 - 87  

  Areas section drop-downs,   86 - 87  
  docking,   85  
  rearranging,   85 - 86  
  undocking,   85   

   PivotTable Style Options group,   60   

   PivotTable Styles gallery,   60   

   Play axis,   276   

   Play dimension,   276   

   populating  

  shell reports, with GetPivotData,   
395 - 398   

   Power View,   261  

  adding drill-down to charts,   267 - 268  
  alignment,   265  
  animating pivot table data on maps, 

  277 - 280  
  animating scatter charts over time,   276  
  beginning new elements,   268  
  calculations, changing,   274 - 275  
  Card View,   274 - 275  
  chart points,   268  
  charts, replicating,   273  
  converting tables to charts,   265 - 267  
  dashboards,   264 - 265  

  creating,   263 - 264  
  filter icons,   265  
  Filter pane,   269 - 271  
  preparing data for pivot table report-

ing,   261 - 263  
  showing data on a map,   273 - 274  
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  slicers,   269  
  sorting,   265  
  Table View,   274 - 275  
  tile boxes, filtering charts,   271 - 272  
  tips for,   277   

   Power View window,   264   

   PowerCache,   249   

   PowerPivot,   215 ,  218 ,  384  

  benefits of, with Excel Pro Plus,   217  
  combination layouts,   258  
  creating pivot tables,   249 - 250  
  DAX Formula language,   216  
  KPIs (key performance indicators), 

  255  
  setting up KPI compared to abso-

lute value,   255 - 257  
  setting up KPI compared to calcu-

lated target values,   256 - 257  
  merging data from multiple tables, 

  215 - 216  
  versus regular pivot tables,   236 - 237  
  relationships,   259  
  sorting by custom lists,   248 - 249  
  SQL Server,   258 - 259  
  unlimited rows,   216   

   PowerPivot add-in, Excel 2013 Pro Plus, 

  228 - 229  

  adding   
  calculated columns using DAX, 

  234 - 235  
  data by copying and pasting,   233  
  data by linking,   233 - 234   
   building pivot tables,   235 - 236  

  enabling PowerPivot,   229  
  importing text files,   229 - 233  
  relationships,   234   

   PowerPivot Data Model,   185 ,  302  

  benefits of,   216 - 217  
  limitations of,   217 - 218   

   preparing for pivot table reporting, data, 

  17 - 18  

  applying type formatting to fields,   20  
  avoiding repeating groups as columns, 

  19  
  avoiding storing data in headings,   

18 - 19  
  eliminating gaps and blank cells in 

your data source,   20  
  ensuring data is in tabular layout,   18  
  good data source design,   20   

   preventing GetPivotData, by typing the 

formula,   387   

   primary keys,   169   

   Product,   64   

   Project Explorer, Visual Basic Editor,   297   

   properties,   299   

   Properties window, Visual Basic Editor,   298    

  Q 
   QuickExplore, Data Model,   223 - 226    

  R 
   ranges, multiple ranges,   157   

   rank, showing,   70 - 71   

   rank number fields, adding,   365 - 366   

   rearranging  

  pivot tables,   28  
  time intelligence,   251  

  PivotTable Fields list,   85 - 86   
   Recommended PivotTables,   30 - 32   

   Record Macro dialog,   282 ,  286   

   recorded macros, altering,   286 - 290   

   recording macros,   282 - 283   

   recordsets, filtering ShowDetail,   338 - 340   

   redistricting, grouping text fields,   81 - 83   

   reducing size of pivot table reports,   

366 - 367   

   referencing totals, calculations,   129   

   RefreshAll method,   360   
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   refreshing pivot tables   

   all pivot tables in a workbook at the 
same time,   360  

  automatically,   359 - 360   
   RELATED(),   238   

   Related Column (Primary),   169   

   relationships  

  Data Model,   169 - 170  
  Excel 2013,   353  

  defining in Data Model,   221 - 222  
  PowerPivot,   259  
  PowerPivot add-in, Excel 2013 Pro 

Plus,   234   
   removing  

  conditional formatting,   151  
  subtotals,   65 - 67  
  tables from Data Model,   172   

   Repeat All Data Items,   363   

   Repeat Item Labels,   363   

   replacing blanks with zeros,   49 - 50   

   replicating  

  charts in Power View,   273  
  pivot table reports for each item in a 

filter,   104 - 106   
   Report Filter area,   103   

   Report Filters,   94 ,  104   

   report filters, creating,   29 - 30   

   report layout changes,   51 - 52  

  blank lines,   56 - 59  
  Compact form,   52 - 53  
  Grand Totals,   56 - 59  
  Outline Form layout,   53 - 54  
  settings,   56 - 59  
  Tabular layout,   54 - 55   

   reports  

  creating for each region or model, 
  340 - 344  

  pivot table reports,   9  
  updating GetPivotData,   398 - 399   

   reports showing revenue by category,   

312 - 315  

  adding subtotals to get page breaks, 
  322 - 323  

  changing default number format,   
318 - 319  

  controlling sort order with AutoSort, 
  318  

  copying finished pivot tables as values 
to a new workbook,   320 - 321  

  eliminating blank cells,   317 - 318  
  formatting,   321  
  putting it all together,   323 - 326  
  rolling daily dates up to years,   315 - 317  
  suppressing subtotals for multiple row 

fields,   319 - 320  
  table layout,   315   

   rolling daily dates up to years, reports 

showing revenue by category,   315 - 317   

   row area, filling blank cells,   307   

   Row field, multiple consolidation ranges 

pivot table,   163   

   row fields  

  filling empty cells,   362 - 364  
  filters,   95  

  check boxes,   95  
  Date Filters,   102 - 103  
  Label Filters,   97 - 99  
  Report Filter area,   103  
  search boxes,   96 - 97  
  Top 10 filter,   100 - 101  
  Values columns,   99 - 100   

   rows, PowerPivot,   216   

   rows area, pivot tables,   13   

   rules  

  for calculated fields,   129 - 131  
  for calculated items,   131  
  custom conditional formatting rules, 

  152 - 156  
  for pivot charts,   139 - 141   

   Running Total, tracking,   71 - 72    
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  S 
   Salas, Pito,   3   

   scatter charts, animating over time,   276   

   scrollbars, adding,   287   

   search boxes, filters,   96 - 97   

   search filter,   346-347     

   section headings, avoiding storing data in, 

  18 - 19   

   security, macros,   283   

   Select a Rule Type,   153 - 154   

   sets,   75   

   SharePoint,   185   

   sharing  

  links to web workbooks,   188 - 189  
  pivot cache,   39 - 40  
  pivot tables with other versions of 

Office,   192   
   shell reports  

  building GetPivotData,   393 - 394  
  populating with GetPivotData,   

395 - 398   
   Show Pages,   341   

   Show Value As,   68 - 69   

   Show Values As tab,   333 - 334   

   ShowDetail,   338 - 340 ,  379   

   showing percentage of total,   70   

   showing rank,   70 - 71   

   size of pivot table reports, reducing,   

366 - 367   

   SkyDrive,   185 - 186   

   SlicerCache,   350 - 351   

   SlicerItem,   350   

   slicers,   32 ,  75 ,  192  

  creating  
  standard slicers,   32 - 35  
  timeline slicer,   35 - 37  

  driving multiple pivot tables from one 
set of slicers,   109 - 111  

  filtering,   106 - 108  
  Power View,   269  
  setting up to filter,   349 - 351   

   solve Order dialog,   133   

   sorting  

  controlling with AutoSort,   318  
  by custom lists, PowerPivot,   248 - 249  
  data items in a unique order,   361  
  pivot tables,   87  

  custom lists,   92 - 93  
  customers into high-to-low 

sequence based on revenue,   87 - 90  
  manual sort sequence,   91 - 92  

  Power View,   265   
   source data tab, deleting,   367   

   SQL Server  

  creating pivot tables,   178 - 181  
  PowerPivot,   258 - 259   

   SQL Server Analysis Services 2012,   194   

   standard slicers, creating,   32 - 35   

   StdDev,   65   

   StdDevP,   65   

   storing data in section headings (avoiding), 

  18 - 19   

   structure of OLAP cubes,   197 - 198   

   styles  

  customizing,   60 - 62  
  modifying with document themes,   62   

   subtotals  

  adding,   65 - 67  
  to get page breaks,   322 - 323  
  for one field,   66 - 67  

  removing,   65 - 67  
  suppressing  

  for multiple row fields,   319 - 320  
  when you have many row fields, 

  65 - 66   
   Sum,   64   

   SUMIFS,   237   

   summarizing forecasts,   120 - 124   

   summary calculations  

  changing,   63  
  functions,   64 - 65  

  why one blank cell causes a count, 
  63 - 64   
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   suppressing subtotals  

  for multiple row fields,   319 - 320  
  when you have many row fields,   65 - 66   

   synchronizing pivot tables with combo 

box,   290 - 294    

  T 
   table layout, reports showing revenue by 

category,   315   

   table styles, restoring gridlines,   46 - 47   

   Table View, Power View,   274 - 275   

   tables  

  adding  
  to Data Model,   170 - 171 ,  220   - 222  
  to Data Model (Excel 2013),   

352 - 353  
  comparing using pivot tables,   368 - 369  
  converting to charts, Power View,   

265 - 267  
  joining using Data Model in Excel 

2013,   218  
  preparing data,   219 - 220  

  Power View, dashboards,   264 - 265  
  removing from Data Model,   172   

   Tabular layout,   54 - 55   

   preparing data for pivot table report-
ing,   18   

   TEXT,   237   

   text fields, grouping for redistricting,   81 - 83   

   text files, importing PowerPivot (Excel 2013 

Pro Plus),   229 - 233   

   themes, document themes,   62   

   thousands separators, adding,   47 - 49   

   thumbnails  , 2   

   tile boxes, filtering charts (Power View), 

  271 - 272   

   time intelligence,   251 - 254  

  rearranging pivot tables,   251   
   timeline slicer  , 2  

  creating,   35 - 37   

   timelines,   75  

  filtering,   106 - 108  
  by date,   108 - 109   

   tools, Visual Basic,   298   

   Top 10 filter,   100 - 101   

   totals, controlling,   308 - 309   

   tracking  

  % of Parent Item,   72  
  relative importance with Index option, 

  73  
  Running Total,   71 - 72   

   tracking Running Total and % of Running 

Total, % of Running Total,   71 - 72   

   transposing data sets with pivot tables, 

  371 - 374   

   turning off GetPivotData,   384 -     388   

   turning pivot tables into hard data,   

361 - 362   

   type formatting, applying to fields,   20    

  U 
   undocking, PivotTable Fields list,   85   

   ungrouping,   79   

   updating reports, GetPivotData,   398 - 399   

   user interfaces, creating with form controls, 

  284 - 286    

  V 
   value fields  

  changing calculations,   67 - 69  
  displaying change from previous 

fields,   72  
  showing percentage of total,   70  
  showing rank,   70 - 71  
  tracking % of Parent Item,   72  
  tracking relative importance with 

Index option,   73  
  tracking Running Total and % of 

Running Total,   71 - 72  
  use % Of,   70  
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  multiple consolidation ranges pivot 
table,   164   

   value filters,   345   

   values, converting pivot tables to,   56   

   Values area  

  adding fields to reports, DAX calcu-
lated fields,   244 - 246  

  adding numeric fields to, Data Model 
(Excel 2013),   354 - 355   

   values area, pivot tables,   12 - 13   

   Values columns, filters,   99 - 100   

   Var,   65   

   Variable Cost Next Year field,   123   

   VarP,   65   

   VBA (Visual Basic for Applications),   295  

  building pivot tables,   302 - 304  
  adding fields to data area,   304 - 305  

  enabling,   295 - 296  
  End With,   301  
  Exploding data sets to different work-

books,   379   
   file formats, macros,   296 - 297  
  macro recorder,   298 - 299  
  object variables,   300 - 301  
  object-oriented code,   299  
  pivot tables  

  formatting,   305 - 307  
  limitations of,   307 - 312  

  totals, controlling,   308 - 309  
  versions,   301 - 302  
  With,   301  
  writing code to handle any size data 

range,   299 - 300   
   versions, VBA (Visual Basic for 

Applications),   301 - 302   

   VertiPaq,   216   

   Visual Basic Editor,   297 - 298   

   Visual Basic for Applications.     See  VBA  

   Visual Basic, tools,   298   

   VLOOKUP,   219 ,  237    

  W 
   web pages  

  designing workbooks as,   186 - 188  
  embedding workbooks,   189 - 191   

   web workbooks, sharing links to,   188 - 189   

   What-If analysis, OLAP data,   211 - 212   

   With, VBA (Visual Basic for Applications),   301   

   workbooks  

  copying pivot tables as values to,   
320 - 321  

  designing as interactive web pages,   
186 - 188  

  embedding in blog posts or web pages, 
  189 - 191  

  exploding data sets to,   379 - 381  
  refreshing all pivot tables at the same 

time,   360  
  sharing links to web workbooks,   188 - 189   

   worksheet functions, calculations,   129   

   writing code to handle any size data range, 

VBA (Visual Basic for Applications),   

299 - 300   

   X-Y-Z   
   xlAfter,   347   

   xlAfterOrEqualTo,   347   

   xlAverage,   327   

   xlBefore,   347   

   xlBeforeOrEqualTo,   347   

   xlCaptionContains filter,   349   

   xlCount,   327   

   xlCountNums,   327   

   xlMax,   327   

   xlMin,   327   

   xlProduct,   327   

   xlStDev,   328   

   xlStDevP,   328   

   xlSum,   328   

   xlVar,   328   

   xlVarP,   328     
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